EPSON Stylus® C84

Printer Basics
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use with this EPSON product. EPSON is not responsible for any use of this information as applied to other equipment.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION's operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be misused by improper copying or printing of copyrighted material. While some countries' laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

EPSON, EPSON Stylus, MicroWave, and EPSON ESC/P are registered trademarks and PRINT Image Matching is a trademark of SEIKO EPSON CORPORATION.

DuraBrite and BorderFree are registered trademarks, Resolution Performance Management, RPM, PhotoEnhance, and EPSON Software are trademarks and EPSON Store, EPSON PhotoCenter, EPSON Connection, and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
Contents

WELCOME! ................................................................. 7
About Your Software .................................................. 8
About Your Documentation ........................................ 8
Using the EPSON Printer Information Center .................. 9
   Launching the Animations ...................................... 9
   Launching the Manual ........................................... 10
Installing Printer Software for Windows NT 4.x .............. 10

LOADING PAPER ....................................................... 11
Loading Single Sheets .............................................. 11
Loading Envelopes .................................................. 12
Loading Special Papers .......................................... 13

PRINTING WITH WINDOWS ......................................... 15
Printing From an Application .................................... 16
Selecting Default Settings ....................................... 18
Customizing Windows Print Settings .......................... 19
Selecting the Correct Paper Type ............................... 21
Printing Borderless Photos ...................................... 22
   BorderFree Paper .............................................. 22
   Loading Paper ................................................. 23
   Printing Your Photos ......................................... 24

PRINTING WITH A MACINTOSH .................................. 27
Printing With Macintosh OS X .................................. 28
Printing With Macintosh OS 8.6 to 9.x ......................... 31
Welcome!

The EPSON Stylus® C84 printer is the ideal desktop printer for business and home use. With its exceptional speed and print resolutions, it is practical for everyday use, yet capable of delivering superior photo printing. It provides you with these advanced features:

■ EPSON's exclusive DuraBrite® inks. These quick-drying inks are resistant to water and fading, so prints stand the test of time. Because the ink particles remain near the surface and don't bleed through, they're ideal for double-sided prints.

  Note: The light resistance of prints is rated up to 80 years on specialty papers, and 70 years on plain paper. The light resistance rating is based on accelerated testing of prints on EPSON® special media, displayed indoors, under glass. Actual print stability will vary according to media, printed image, display conditions, light intensity, humidity, and other atmospheric conditions. EPSON does not guarantee the longevity of prints. For maximum print life, display all prints under glass or lamination or properly store them.

■ True BorderFree® frame-ready prints on select 4 x 6 and letter-size papers.

■ Resolution Performance Management™ (RPM™) technology, which optimizes the number and placement of ink droplets on various papers. Delivers superior photo quality with manageable print file sizes.

■ Exif (Exchangeable Image File) Print format support. This international standard ensures the accurate reproduction of your digital camera images. Most digital cameras store Exif Print information, such as shutter speed, metering, flash, and exposure settings, in the JPEG image file. Your printer, with EPSON Software™ Film Factory,™ uses these settings to create accurate prints.
About Your Software

Your printer CD-ROM includes all the software you need for printing. See the Start Here sheet for installation instructions.

- **Your printer driver** runs your printer and lets you control how your documents look. You can’t print without it.
  
  **Tip:** It’s a good idea to check EPSON’s support website periodically for free updates to your printer driver. Visit http://support.epson.com.

- **Your EPSON Printer Information Center** gives you quick, on-screen access to information about your printer. It includes animated tutorials and an on-screen User’s Guide for complete information about your printer.

- **EPSON Software Film Factory** is a photo management program that lets you organize, beautify, and print your photos in a flash. Supports PRINT Image Matching™ (P.I.M. II) and Exif Print.

- **EPSON PhotoCenter™** is EPSON’s free photo-sharing website where you can store, organize, and share your photos; print high-resolution photos; and create online postcards. Add a link to EPSON PhotoCenter with your software installer.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet.

This book contains system requirements, important safety information, your warranty, and instructions on loading all types of paper, printing with Windows® or on a Macintosh®, maintaining the printer, and solving basic problems.

Please follow these guidelines throughout:

- **Warnings** must be followed carefully to avoid bodily injury.
- **Cautions** must be observed to avoid damage to your equipment.
- **Notes** contain important information about your printer.
- **Tips** contain hints for better printing.

For more details about your printer, see your animated tutorials and User’s Guide.
Using the EPSON Printer Information Center

Need help loading special paper, replacing ink cartridges, or cleaning the print head? The EPSON Printer Information Center (EPIC) has animations that quickly show you how. EPIC also includes an on-screen User’s Guide with additional printer details. See the Start Here sheet to install the EPSON Printer Information Center.

**Note:** You need a browser—such as Microsoft® Internet Explorer® 4.0 or later or Netscape® Navigator® 4.0 or later—to view the manual. If you are using a different browser, the pages may not display correctly.

Launching the Animations

1. Double-click the EPSON Printer Information Center icon on your desktop.
2. Click Print Show.
3. Click a title. The movie starts playing.
4. Click Exit to exit EPSO N Print Show.

Use the program tools to pause a movie, replay a step, or skip ahead.
Launching the Manual

1. Double-click the EPSON Printer Information Center icon on your desktop.
2. Click User's Guide.
3. Click on the topic you want to view.

Installing Printer Software for Windows NT 4.x

Before you begin, complete the instructions on the Start Here sheet for setting up your printer. For instructions on installing printer software in Windows XP, Me, 2000, 98, or on a Macintosh, see your Start Here sheet.

Note: Use a parallel cable to connect the printer to your computer. Windows NT® 4.x does not support a USB connection.

1. Turn on your computer. (Make sure your printer is still on.)
2. Put the EPSON CD-ROM in your drive.
3. Read the license agreement and click Agree to continue with the installation.
4. When you see the Main Menu, click Install Printer Driver. Wait while the files are copied to your computer.
5. Click OK when you see a message that setup is complete.
6. Click Install Manual and Printer Movies and follow the on-screen instructions to install the EPSON Printer Information Center.
7. Click Exit. When you see the EPSON Product Registration screen, register your printer as instructed.
8. Restart your computer.

Note: EPSON Software Film Factory does not support Windows NT 4.x.

You're ready to start printing! See the instructions beginning on page 11.
Loading Paper

Follow the steps in these sections to load paper in your printer:

- “Loading Single Sheets” below
- “Loading Envelopes” on page 12
- “Loading Special Papers” on page 13

Loading Single Sheets

1. Open the output tray and its extension.
2. Fan the stack of paper and place it against the right edge guide. Don’t push the paper in.
3. Press in the side of the left edge guide and slide it against the paper, but not too tightly.
Follow these guidelines when loading paper:

- Don’t load paper above the arrow on the left edge guide. Also make sure the paper is under the tabs on the left and right edge guides.
- Load the printable side face up. It’s usually whiter or brighter than the other side.
- Always load the short edge first, even when printing in landscape mode.
- Load letterhead or preprinted paper into the printer top edge first.
- If you experience paper feeding problems, try loading fewer sheets.

### Loading Envelopes

1. Open the output tray and its extension.
2. Load up to 10 envelopes at a time, flap edge left, printable side up, against the right edge of the sheet feeder.
3. Slide the left edge guide against the envelopes (but not too tightly). Make sure the envelopes are under the tabs on the left and right edge guides.

**Note:** For best results, press each envelope flat before loading, or load one envelope at a time.

Select the following settings when printing on envelopes:

- Plain paper as the Type or Media Type setting
- The correct envelope size as the Size (Windows) or Paper Size (Macintosh) setting
- Landscape as the Orientation setting

For instructions on selecting these settings, see: “Printing With Windows” on page 15, “Printing With Macintosh OS X” on page 28, or “Printing With Macintosh OS 8.6 to 9.x” on page 31.
Loading Special Papers

EPSON offers the following special ink jet papers for the EPSON Stylus C84:

<table>
<thead>
<tr>
<th>Paper name*</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>EPSON DuraBrite Ink Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041731</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper or EPSON Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041114/S041649/S041271/S041272</td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>Enhanced Matte Paper (Archival Matte Paper)</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041341</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041064</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041054</td>
</tr>
</tbody>
</table>

* The availability of paper types varies by location.

To order EPSON ink cartridges, paper, and other printing media, contact your dealer or call EPSON at (800) 873-7766 or visit the EPSON Store at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
To load EPSON ink jet papers, follow these guidelines:

- Load all single-sided paper with the printable side up. It's usually whiter or brighter than the other side.
- If the paper has a cut corner, position it in the upper right corner as you load it in the sheet feeder.
- Check the paper package for additional instructions on using special papers.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premium Bright White Paper</td>
<td>120 Sheets</td>
</tr>
<tr>
<td>Photo Quality Inkjet Paper</td>
<td>80 sheets</td>
</tr>
<tr>
<td>EPSON DuraBrite Inkjet Glossy Photo Paper</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Glossy Photo Paper or Photo Paper</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Matte Paper Heavyweight</td>
<td>20 sheets with a support sheet beneath the stack</td>
</tr>
<tr>
<td>Double-Sided Matte Paper</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Enhanced Matte Paper (Archival Matte Paper)</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Inkjet Transparencies</td>
<td>20 sheets with a sheet of plain paper beneath the stack</td>
</tr>
<tr>
<td>Photo Quality Inkjet Cards</td>
<td>30 cards with a support sheet beneath the stack</td>
</tr>
</tbody>
</table>
Printing With Windows

Before you start, make sure your printer is set up and its software is installed as described on the Start Here sheet. (For Windows NT 4.x, see page 10 to install your printer software.)

Whenever you print, make sure you do the following:

■ Use the right paper.
   For the best-looking photos, most vivid colors, and greatest detail, always use genuine EPSON papers and EPSON inks.

■ Choose the right printer settings.
   Your printer automatically adjusts itself for each type of paper. That’s why printer settings are important. They tell your printer what kind of paper you’re using and what type of print you want. Make sure you check your printer settings every time you print.
Printing From an Application

After you create a document in a software program, follow these steps to print it using the basic printer settings:

1. From the file menu, click Print. You see a Print window like this one:

   ![Print window]

   - Select your printer name here
   - Click here to open your printer software

2. Make sure EPSON Stylus C84 Series is selected.

3. Click the Preferences or Properties button. (If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.)
4. Select the following in the preferences window:

5. Select from these Quality Option settings:
   - **Draft**: for rough drafts with reduced print quality
   - **Text**: for text-only documents with higher text quality
   - **Text & Image**: for documents with text and images with higher quality
   - **Photo**: for photos and graphics with good quality and speed
   - **Best Photo**: for photos or graphics with high print quality

   **Note**: The Quality Option settings on this screen give you the best combination of quality and speed for most prints. For the highest quality (Photo RPM) on selected papers, click the Advanced button on the Main tab. Then see “Customizing Windows Print Settings” on page 19 for instructions on selecting Photo RPM.

6. Select the paper Type for the paper you’ve loaded. See “Selecting the Correct Paper Type” on page 21 for more information about paper types.

7. Select other settings as shown above.
   **Tip**: For more information about printer settings, click the ? or Help button.
8. Click OK.

9. At the Print window, click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You can use the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

Tip: You can also cancel printing by pressing the paper button on your printer.

Selecting Default Settings

Your printer settings only apply to the program you’re currently using. If you want, you can change the Windows default printer settings for all your programs.

1. Right-click the printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown in “Printing From an Application.”

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.
Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

   ![Advanced Settings](image)

   - Select Paper & Quality Options as necessary
   - Click here to select Photo RPM for the best print quality on photo and glossy paper types
   - Select Print Options as necessary
   - Select a color management method
     (To choose No Color Adjustment, click ICM first)

   **Note:** For the highest print quality, select Photo RPM. Please note that printing will take longer in this mode.

   For more information about advanced settings, or instructions on saving them as a group so you can reuse them later, click the ? or Help button. If you want to use the Advanced screen each time you access your printer settings, select the Show this screen first checkbox.
4. Once you’ve finished selecting advanced settings, you can:
   ■ Click OK to save your settings, return to the Print dialog box, and print.
   ■ Click the Basic button to return to the Basic settings.
   ■ Click the Page Layout tab and continue with step 5 to select layout options.

5. Select the following page layout settings as necessary:

6. Click OK to save your settings, then click OK or Print.
Selecting the Correct Paper Type

Select the correct paper Type setting so your printer knows what kind of paper you’re using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td></td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Enhanced Matte Paper (Archival Matte Paper)</td>
<td></td>
</tr>
<tr>
<td>EPSON DuraBrite Ink Glossy Photo Paper</td>
<td>DURABrite Ink Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
</tbody>
</table>
Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the edges of the page.

BorderFree Paper

Although borderless printing is a bit slower, you get beautiful snapshots and enlargements, without trimming, on these papers and sizes:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>4 × 6</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>4 × 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>EPSON DuraBrite Ink Glossy Photo Paper</td>
<td>4 × 6</td>
<td>DURABrite Ink Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
</tbody>
</table>

With proper care, photographs from your EPSON Stylus printer will last for many years. The special EPSON DuraBrite inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored. For best results, always use EPSON papers.

As with traditional photos, EPSON recommends proper care that will minimize color changes and lengthen display life:

- Frame prints under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, smoke, and high levels of ozone.
- As with all photographs, keep your prints away from direct sunlight.
- For proper storage, keep your prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.
- Always keep unused paper in the original package.
To order EPSON paper, contact your dealer or call the EPSON Store at (800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). In Canada please call (800) 463-7766 for dealer referral.

Loading Paper

Load paper as shown, then see the following section to print.

- Always load the short edge first, even for printing landscape-oriented photos.
- Load the printable side face up. It’s usually whiter or brighter than the other side.
- Make sure the paper is under the tabs on the left and right edge guides.
- Check the paper package for additional loading instructions.
Printing Your Photos

1. Start your photo program and open your photo.
2. Open the File menu and click Print. Then click Properties or Preferences. You see the following:

3. Select Photo or Best Photo as the Quality Option setting.
4. Select one of the following paper types:
   - Matte Paper - Heavyweight
   - Glossy Photo Paper
   - DURABrite Ink Glossy Photo Paper
5. Click the Borderless checkbox. Read the message and click OK.
6. Select your paper Size setting.
7. Select Portrait or Landscape as the orientation setting.
8. Click the Page Layout tab.

9. Adjust the Expansion slider to choose Min, Max, or the in-between setting. Min retains the entire image in your print, but there may be a small white edge on the borders of the print. Max expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

10. Click OK, then click OK or Print.
Printing With a Macintosh

Before you start, make sure your printer is set up and its software is installed as described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ Use the right paper.
  For the best-looking photos, most vivid colors, and greatest detail, always use genuine EPSON papers and EPSON inks.

■ Choose the right printer settings.
  Your printer automatically adjusts itself for each type of paper. That's why printer settings are important. They tell your printer what kind of paper you're using and what type of print you want. Make sure you check your printer settings every time you print.
Printing With Macintosh OS X

If you’re using a Mac OS X compatible printing application, follow the steps below to print a document. (If you’re using an application that’s compatible only with Classic mode, follow the steps in “Macintosh OS 8.6 to 9.x” on page 34 instead.)

1. From the File menu, select Page Setup. Select the following settings:

   - Settings: Page Attributes
   - Format for: Select your printer
   - Paper Size: Select your paper size
   - Orientation: Select your document or image orientation
   - Scale: 100%

2. Select your printer from the Format for drop-down list.

   **Caution:** When printing non-borderless print jobs using a custom page size, make sure the selected size matches the paper you loaded and is within the printable area for your printer. For example, never choose a size wider than 9 inches or longer than 44 inches.

3. Click OK to close the Page Setup window.

4. From the File menu, select Print. You see a window like this one:

   - Printer: Select your printer name from the list
   - Presets: Select Print Settings from the list
   - Copies & Pages: Select the same printer name you chose in step 2
   - Pages: Select Print Settings from the list

5. Select your printer name from the Printer drop-down list.

   **Note:** Make sure you choose the same printer that you selected in step 2.
6. Select Print Settings from the list.

7. Select the following Print Settings as necessary:

![Print Settings screen]

- Select the type of paper you’re using
- Select Color or Black Ink
- Select higher quality or faster printing (if available)

**Note:** For more information about printer settings, click the Help button.

The Quality setting on this screen gives you the best combination of quality and print speed for most prints. For the highest print quality (Photo RPM) on selected papers, click the Advanced button and see “Customizing Macintosh Print Settings” on page 33.

8. You can also choose other print settings by selecting these options in the pull-down menu:

- Copies & Pages: to select the number of copies or a page range
- Layout: to select page layout options
- Output Options: to save your print job as a PDF file
- Color Management: to select ColorSync, adjust the color controls, change the gamma setting, or turn off color adjustments in the printer software
- Summary: to view a list of all your selections
- Save Custom Setting: (OS X 10.1.x only) to save your selections for future use. (In OS X 10.2.x, select Save As from the Presets pop-up menu.)
9. Click Print.

10. To monitor the progress of your print job, click the Print Center icon when it appears in the dock on the bottom of your desktop.

   In OS X 10.2.x, double-click Stylus C84 in the Printer List window.

   You see a screen like this:

   ![Print Center screen]

11. Monitor the progress of your print job or do one of the following:
   - Click the print job, then click Delete to delete the job
   - Click the print job, then click Hold to pause printing
   - Click a print job marked “Hold” and click Resume to resume printing

   Tip: You can also cancel printing by pressing the paper button on your printer.

12. When you’re finished, close Print Center.
Printing With Macintosh OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described on your Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:
   - Choose your paper from the Media Type list. See page 35 for details.
   - Select Color to print a color document or black and white photograph. To print a black text document, click Black.
   - Choose Automatic to get good printing results for most projects.

2. Click OK to close the Page Setup window.

3. From the File menu, select Print. You see a window like this one:

4. Select the following settings:
   - Make sure you see C84 Series
   - Select your paper size
   - Select your paper source
   - Select your document or image orientation
   - Select Automatic mode
   - Select higher quality or faster printing
   - Select the type of paper you're using
   - Select Color or Black Ink

   Choose your paper from the Media Type list. See page 35 for details.
   Select Color to print a color document or black and white photograph. To print a black text document, click Black.
   Choose Automatic to get good printing results for most projects.
Set the slider to Quality to select high-quality printing, Speed for faster printing, or an in-between setting. (The slider is not available for all paper types.)

**Note:** The Quality setting on this screen gives you the best combination of quality and print speed for most prints. For the highest print quality (Photo RPM) on selected papers, click Custom then click the Advanced button and see “Customizing Macintosh Print Settings” on page 33 for instructions on selecting Photo RPM.

5. You can also do the following:
   - Click to reduce/enlarge your printed image, print multi-page layouts, or add a watermark.
   - Click to control background printing and schedule print jobs.
   - Click , then click Preview to preview your printout.
   - Click to check your ink levels.

**Tip:** For more information about printer settings, click the ? button.

6. Click Print.

7. If you turned on background printing, you can select EPSON Monitor IV from the Application menu in the upper right corner of your screen. You see the EPSON Monitor window:

   - Click to check ink levels
   - Select your print job, then click here to cancel printing
   - Click here to show or hide the print settings

**Note:** If you’re not using background printing and you need to cancel printing, hold down the ` key and press the . (period) key.

**Tip:** You can also cancel printing by pressing the paper button on your printer.
Customizing Macintosh Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or selecting a variety of special effects and layouts.

Macintosh OS X

1. To access advanced settings, click Advanced.
2. Select these advanced settings as necessary:

   ![Print Settings](image)

   - **Note:** For the highest print quality, select Photo RPM. Please note that printing will take longer in this mode.

   For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click Help.

3. Click Print.
Macintosh OS 8.6 to 9.x

1. On the printer settings window, click Custom, then click Advanced.

2. Select these advanced settings as necessary:

   - **Note:** For the highest print quality, select Photo RPM. Please note that printing will take longer in this mode.

   For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click the ? button.

3. Click OK to save your settings, then click Print.
## Selecting the Correct Paper Type

Select the correct Media Type setting so your printer knows what kind of paper you’re using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td></td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Enhanced Matte Paper (Archival Matte Paper)</td>
<td></td>
</tr>
<tr>
<td>EPSON DuraBrite Ink Glossy Photo Paper</td>
<td>DURABrite Ink Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
</tbody>
</table>
Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the edges of the page.

Although borderless printing is a bit slower, you get beautiful snapshots and enlargements, without trimming, on these papers and sizes:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>4 × 6</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>4 × 6</td>
<td></td>
</tr>
<tr>
<td>EPSON DuraBrite Ink Glossy Photo Paper</td>
<td>4 × 6 Letter (8.5 × 11 inches)</td>
<td>DURABrite Ink Glossy Photo Paper</td>
</tr>
</tbody>
</table>

With proper care, photographs from your EPSON Stylus printer will last for many years. The special EPSON DuraBrite inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored. For best results, always use EPSON papers.

As with traditional photos, EPSON recommends proper care that will minimize color changes and lengthen display life:

- Frame prints under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, smoke, and high levels of ozone.

- As with all photographs, keep your prints away from direct sunlight.

- For proper storage, keep your prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.

- Always keep unused paper in the original package.

To order EPSON paper, contact your dealer or call the EPSON Store at (800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). In Canada please call (800) 463-7766 for dealer referral.
Loading Paper

Load paper as shown below, then follow the instructions for your operating system.

- Always load the short edge first, even for printing landscape-oriented photos.
- Load the printable side face up. It's usually whiter or brighter than the other side.
- Make sure the paper is under the tabs on the left and right edge guides.
- Check the paper package for additional loading instructions.

Macintosh OS X

1. Start your photo program and open your photo.
2. Open the File menu and click Page Setup. You see the following:

   - Select Stylus C84(Sheet Feeder - Borderless) in the Format for drop-down list.

3. Select Stylus C84(Sheet Feeder - Borderless) in the Format for drop-down list.

   **Caution:** When printing borderless photos, select one of the supported paper sizes listed on page 36; never select a custom or unsupported paper size or ink may spray inside your printer.

5. Select your document or image orientation.

6. Click OK.

7. Open the File menu and click Print. You see the following:

   ![Select Stylus C84(Sheet Feeder - Borderless)](image)

8. Select Stylus C84(Sheet Feeder - Borderless) in the Printer drop-down list.

   **Note:** Make sure you choose the same printer that you selected in step 3, or you may get unexpected results for your print.

9. Select Print Settings from the pop-up list.

10. Select one of the following Media Types:
    - Matte Paper Heavyweight
    - Glossy Photo Paper
    - DURABrite Ink Glossy Photo Paper

11. Select Quality (for higher quality) or Speed (for faster printing) using the slider.
12. Select Expansion from the pop-up list.

13. Adjust the slider to choose Min, Max, or the in-between setting. Min retains the entire image in your print, but there may be a small white edge on the borders of the print. Max expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

14. Click Print.

**Macintosh OS 8.6 to 9.x**

1. Start your photo program and open your photo.

2. Open the File menu and click Page Setup. You see the following:


4. Click the Borderless checkbox. Read the message and click OK.
5. Click the Expansion button.

6. Adjust the slider to choose Min, Max, or the in-between setting. Min retains the entire image in your print, but there may be a small white edge on the borders of the print. Max expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

7. Select Portrait or Landscape as the orientation setting.

8. Click OK to close the Page Setup window.

9. Open the File menu and click Print.

10. Select one of the following Media Types:

   - Matte Paper - Heavyweight
   - Glossy Photo Paper
   - DURABrite Ink Glossy Photo Paper

11. Select Quality (for higher quality) or Speed (for faster printing) using the slider.

12. Click Print.
Maintaining Your Printer

This section describes maintenance procedures to keep your printer working at its best and preparation steps for moving your printer. Follow the instructions here for:

- “Cleaning the Print Head” (below)
- “Purchasing Ink Cartridges” on page 44
- “Replacing an Ink Cartridge” on page 45
- “Aligning the Print Head” on page 54
- “Cleaning the Printer” on page 57
- “Transporting the Printer” on page 58

To watch printer movies describing how to clean the print head or replace an ink cartridge, double-click the EPSON Printer Information Center icon on your desktop.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

This section explains how to clean the print head using the Head Cleaning utility.

You can also clean the print head by holding down the button on the printer for three seconds. (This only works when the red light is off.)

Caution: When you don’t turn on your printer for a long time, print quality can decline, so turn it on and print a few pages at least once a month to maintain good print quality.
Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red ink light is off. (If the ink light is flashing or on, you need to replace a cartridge; see “Replacing an Ink Cartridge” on page 45 for details.)

2. Windows: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Head Cleaning.

   Macintosh OS X: Open the Applications folder and double-click EPSON Printer Utility. Select Stylus C84 in the printer list, click OK, and select Head Cleaning.

   Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or Print. Click the utility button, then click the Head Cleaning button.

3. Follow the instructions on the screen to clean the print head.

   Cleaning takes several seconds. The printer makes noise and the green power light flashes.

   Caution: Never turn off the printer while the green power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.
4. When the green \( \mathcal{O} \) power light stops flashing, make sure paper is loaded in the printer, then do the following:

**Windows:** Click Print nozzle check pattern. Then click Print.

**Macintosh:** Click Confirmation, then click Next.

The nozzle check pattern prints (see “Examining the Nozzle Check Pattern” below for details).

5. If the nozzle check pattern has no gaps or white lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again.

If you don’t see any improvement after cleaning three or four times, refer to “Problems and Solutions” on page 65.

You can also turn the printer off and wait overnight— this allows any dried ink to soften— and then try cleaning the print head again.

**Examining the Nozzle Check Pattern**

Examine the nozzle check pattern you printed. Each staggered line should be solid, with no gaps, as shown.

- If your printout looks okay, you’re done.
- If you see any gaps (as shown below), clean the print head again; see “Running the Head Cleaning Utility” on page 42 for instructions.
Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the expiration date on the package:

<table>
<thead>
<tr>
<th>Ink cartridge</th>
<th>Part number</th>
<th>Capacity*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black (high capacity)**</td>
<td>T043120</td>
<td>1350 pages ISO/IEC 10561 letter pattern</td>
</tr>
<tr>
<td></td>
<td></td>
<td>950 pages at 5% coverage</td>
</tr>
<tr>
<td>Black (standard capacity)**</td>
<td>T044120</td>
<td>600 pages ISO/IEC 10561 letter pattern</td>
</tr>
<tr>
<td></td>
<td></td>
<td>420 pages of graphics at 5% coverage</td>
</tr>
<tr>
<td>Cyan</td>
<td>T044220</td>
<td>450 pages at 5% coverage</td>
</tr>
<tr>
<td>Magenta</td>
<td>T044320</td>
<td>450 pages at 5% coverage</td>
</tr>
<tr>
<td>Yellow</td>
<td>T044420</td>
<td>450 pages at 5% coverage</td>
</tr>
<tr>
<td>Color multipack (Cyan, Magenta, and Yellow)</td>
<td>T044520</td>
<td>450 pages at 5% coverage per color</td>
</tr>
</tbody>
</table>

* The figure given is based on continuous printing after ink replacement. Cartridge yields will vary with images printed, print settings, paper types, and frequency of use.

** Availability of black ink cartridge types varies by location.

Caution: To ensure good results, use genuine EPSON ink cartridges and do not refill them. Other products may cause damage to your printer not covered by EPSON's warranty.

The high capacity black ink cartridges are recommended as replacement cartridges for this printer for users who print frequently. Users that print infrequently may want to choose the standard capacity black ink cartridges. Your printer includes the high capacity black ink cartridge.

When you need new ink cartridges, contact your dealer, or call the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
Replacing an Ink Cartridge

- When the red \(\bigcirc\) ink light flashes, one or more ink cartridges are low on ink.
- When the red \(\bigcirc\) ink light stays on, you need to replace the cartridge(s).
When you print, you'll also see a message on your screen telling you which cartridge is low or empty.

When a cartridge is more than six months old, you may need to replace it if printouts don't look their best. If the quality doesn't improve after cleaning and aligning the print head, you can replace the cartridge even if the red \(\bigcirc\) ink light is off.

Checking the Ink Supply

To check your ink supply, do the following:
- **Windows**: Double-click the icon on the Windows taskbar. You see a window like this:
**Macintosh OS X:** Double-click the EPSON Printer Utility icon in the Applications folder. Choose C84 Series and click OK. Then click EPSON Status Monitor. You see a window like this:

![EPSON Status Monitor window]

- Click a cartridge image to display information about the cartridge.

**Macintosh OS 8.6 to 9.x:** From the File menu, select Print, then click the ink icon.

**Ink Cartridge Precautions**

**Warning:** Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them thoroughly with water.

**Caution:** Don’t remove the cartridge label, or ink will leak.

Don’t remove the green IC chip from the cartridge. Installing a cartridge without an IC chip can damage the printer. Avoid touching the green IC chip, as this can damage the ink cartridge.

If you remove an ink cartridge temporarily, protect the ink supply port on the bottom of the cartridge from dirt and dust. Place it in a small box, or, if you have the original packaging, return it to its own box.

Store ink cartridges in the same environment as the printer. Stand the cartridges upright (the label identifying the color should be on the top).
Replacing an Empty or Low Ink Cartridge

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge replacement procedure, you must complete all the steps in one session.

Follow these steps to replace ink cartridges when the red ink out light is flashing or on:

1. Make sure the printer is turned on and not printing. The power light should be on, but not flashing.
2. Lower the output tray and open the printer cover.
3. Press the ink button for one second. The print head moves to the left, and the cartridge that needs to be replaced stops under the mark. The power light also begins to flash.

Caution: Don’t press the ink button for more than 2 seconds, or the printer will start to clean the print head.

To avoid damaging the printer, never move the print head by hand.

4. Press the ink button again.
   - If more than one ink cartridge is empty, the next cartridge moves under the mark. This happens after you press the ink button for every ink cartridge that needs to be replaced.
If all the empty cartridges have been identified, the print head moves to the ink cartridge replacement position.

5. Open the cartridge cover.

6. Pinch the back tab of the empty cartridge as you lift it out of the printer. Don't take the used cartridge apart or try to refill it.
**Warning:** If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water.

7. **Before you remove the new cartridge from its package, shake it four or five times.**

![Shaking Cartridge](image1)

8. **Remove the cartridge from its package and lower it into the cartridge holder. Push down gently until the cartridge is firmly seated.**

![Cartridge Holder](image2)

9. **Repeat steps 5 through 7 for each cartridge that you need to replace.**
10. Close the cartridge cover.

11. Close the printer cover and press the ink button for one second. The printer moves the print head and begins charging the ink delivery system.

The green power light flashes and the printer makes noise. Charging takes about one minute. When it's finished, the power light stops flashing and stays on.

Note: Never turn off the printer while the power light is flashing, unless the printer hasn't moved or made noise for more than 5 minutes.

Replacing a Cartridge When Print Quality Declines

Even if the ink out light isn’t flashing or on, you may need to replace an ink cartridge if it’s been installed in your printer for more than six months and print quality declines.

Follow these steps to replace old ink cartridges:

1. Print a nozzle check pattern to determine which cartridges need to be replaced:

Windows: Right-click the printer icon on the Windows taskbar, and then click Nozzle Check.

Macintosh OS X: Open your Applications folder and double-click the EPSON Printer Utility icon. Select C84 Series in the printer list and click OK. Then click Nozzle Check.

Macintosh 8.6 to 9.x: Open your application’s File menu and choose Print. Click the Utility button, then click the Nozzle Check button.
2. Follow the instructions on the screen to print the nozzle check pattern. Then examine the pattern for gaps in the lines. You need to replace only those cartridges whose colors show gaps in the line pattern, as shown below.

3. Make sure you have the correct replacement cartridges.

   **Note:** You must have the new ink cartridges before you continue. Once you start the ink cartridge replacement procedure, you must complete all the steps in one session.

4. Lower the output tray and open the printer cover.

5. Press the ink button. The print head moves to the ink cartridge replacement position, and the power light begins to flash.

   **Note:** Don’t press the ink button for more than 2 seconds, or the printer will start to clean the print head.

   **Caution:** To avoid damaging the printer, never move the print head by hand.
6. Open the cartridge cover.

7. Pinch the back tab of the cartridge as you lift it out of the printer. Don’t take the used cartridge apart or try to refill it.

Warning: If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water.

8. Before you remove the new cartridge from its package, shake it four or five times.
9. Remove the cartridge from its package and lower it into the cartridge holder. Push
down gently until the new cartridge is firmly seated.

10. Repeat steps 7 through 9 for each cartridge you want to replace.
11. Close the cartridge cover.

12. Close the printer cover and press the ink button for one second. The printer
moves the print head and begins charging the ink delivery system.

The green power light flashes and the printer makes noise. Charging takes
about one minute. When it's finished, the power light stops flashing and
stays on.

**Note:** Never turn off the printer while the power light is flashing, unless the
printer hasn't moved or made noise for more than 5 minutes.
Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark horizontal banding, you may need to align the print head.

**Note:** Banding may also occur if your cartridges are low on ink or you need to clean the print head.

1. Turn on the printer.
2. Load several sheets of paper.
3. **Windows:** Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Print Head Alignment.

**Macintosh OS X:** Open the Applications folder and double-click the EPSON Printer Utility icon. Select C84 Series in the printer list, click OK, and select Print Head Alignment.

**Macintosh OS 8.6 to 9.x:** From the File menu, select Page Setup or Print. Click the Utility button, then click the Print Head Alignment button.

4. Follow the instructions on the screen to print a black vertical alignment test page. You see this screen:

![Windows Print Head Alignment](image)

![Macintosh Print Head Alignment](image)
5. Look at the five sets of patterns in your printout. For each set, if you see a pattern with no visible vertical lines, enter its number in the corresponding box on the screen and click Next.

If you can’t find a pattern without any vertical lines, select the best pattern and click Realignment. Then repeat this step.

6. Click Print to print the color vertical alignment sheet. You see this screen:

![Windows Print Head Alignment](image)

7. Look at the four sets of patterns in your printout. For each set, if you see a pattern with no visible vertical lines, enter its number in the corresponding box on the screen and click Next.

If you can’t find a pattern without any vertical lines, select the best pattern and click Realignment. Then repeat this step.
8. Click Print to print a black horizontal alignment sheet. You see this screen:

![Windows Print Head Alignment screen](image1)

![Macintosh Print Head Alignment screen](image2)

9. In your printout, select the pattern with no gap or line between the rectangles. Enter its number in the box on the screen and click **Next**.

If you can’t find an aligned pattern, choose the best pattern and click **Realignment**. Then repeat this step.

10. Click Print to print a color horizontal alignment sheet. You see this screen:

![Windows Print Head Alignment screen](image3)

![Macintosh Print Head Alignment screen](image4)
11. In your printout, find the pattern with no gap or line between the rectangles and enter its number in the box on the screen.

If you can’t find an aligned pattern, choose the best pattern and click Realignment. Then repeat this step.

12. Click Finish to close the Print Head Alignment Utility.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the outer case or inside of the sheet feeder is dirty, clean it with a soft cloth dampened with mild detergent. Keep the printer cover closed to prevent water from getting inside.

4. If ink accidentally gets inside the printer, wipe off the rollers shown below with a damp cloth.

![Cleaning the Printer](image)

**Warning:** Don’t touch the gears or any other parts inside the printer.

**Caution:** Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner for cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils inside the printer.
Transporting the Printer

If you need to ship your printer, you must prepare it for transportation by removing the ink cartridges and packing the printer in its original box or one of a similar size.

1. Turn on the printer.
2. Remove any paper from the printer, then remove the paper support.
3. Open the printer cover.
4. Press the ink button. The print head moves to the ink cartridge replacement position, and the power light begins to flash.

**Note:** Don’t press the ink button for more than 2 seconds, or the printer will start to clean the print head.

**Caution:** To avoid damaging the printer, never move the print head by hand.

5. Open the cartridge cover.
6. Pinch the back tab of each cartridge as you lift it out of the printer. Remove all the cartridges. Store the ink cartridges in a plastic bag or container, making sure that the tops of the cartridges are facing up.

![Image of cartridge removal process]

**Warning:** If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water.

7. Close the cartridge cover and press the ink button. Wait until the print head locks in the far right position. (Don’t worry if the ink light is on.)

8. Press the power button to turn off the printer. Unplug the power cord from the electrical outlet. Then disconnect the printer cable from the printer.


![Image of tape securing]

**Caution:** Be sure to remove the tape and reinstall the ink cartridges immediately after installing the printer in its new location.

10. Close the printer cover, push in the output tray extension, then close the output tray.
11. Repack the printer and its attachments in the original box using the protective materials that came with them.

Keep the printer level as you transport it.

After transporting the printer, remove the tape securing the print head, reinstall the ink cartridges, and test your printer. If you notice a decline in print quality, clean the print head as described on page 41; if output is misaligned, align the print head as described on page 54.
Solving Problems

See “Diagnosing Printer Problems” on page 63 to help determine what the cause of your printer problem may be. Then see these sections for solutions.

- “Setup and Software Installation Problems” on page 65
- “Printer Problems” on page 66
- “Quality Problems” on page 68
- “Paper Problems” on page 71
- “Miscellaneous Problems” on page 72
- “Uninstalling Printer Software” on page 74
- “Where To Get Help” on page 76

**Tip:** It’s a good idea to check EPSON’s support web site periodically for possible updates to your printer driver. Visit http://support.epson.com and check the section for your product to see if there is a new driver available, free of charge, for downloading to your computer. Download instructions are posted for your convenience.
Printer Parts

- Ink button
- Paper button
- Power button
- Sheet feeder
- Left edge guide
- Paper support
- Right edge guide
- Output tray
- Output tray extension
- Printer cover
- Parallel port
- USB port
## Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see “Running a Printer Check” on page 64).

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green ⚫ power light flashes</td>
<td>The printer is receiving a print job, charging ink, cleaning the print head, or ink is being replaced.</td>
</tr>
<tr>
<td>Red ⚫ paper light on</td>
<td>Your paper ran out. Load more and press the ⚫️ paper button.</td>
</tr>
<tr>
<td>Red ⚫️ paper light flashes</td>
<td>Paper is jammed in the printer. Press the ⚫️️ paper button to eject the jammed paper. If the light is still flashing, open the cover and remove all paper, including any jammed or torn pieces. Then reload paper and press the ⚫️️ paper button to continue printing.</td>
</tr>
<tr>
<td>Red ⚫️ ink light flashes</td>
<td>One of the cartridges is low on ink. Check the message that appears on your screen to determine which cartridge is low or follow the instructions in “Checking the Ink Supply” on page 45. Make sure you have a replacement cartridge.</td>
</tr>
<tr>
<td>Red ⚫️ ink light on</td>
<td>One of the cartridges is out of ink or not installed. Make sure you have a replacement cartridge, then follow the steps in “Replacing an Empty or Low Ink Cartridge” on page 47 to install it. If you have just installed a new cartridge, it may be incompatible with the printer or incorrectly installed. Reinstall it or replace it with the correct cartridge, as described on “Replacing an Empty or Low Ink Cartridge” on page 47.</td>
</tr>
<tr>
<td>Green ⚫️ power light and red ⚫️ ink light are on</td>
<td>One or both of the ink cartridges is not installed correctly. Reinstall cartridges as described in “Replacing an Empty or Low Ink Cartridge” on page 47.</td>
</tr>
<tr>
<td>Green ⚫️ power light is off; red ⚫️️ paper and ⚫️ ink lights flashing alternately</td>
<td>Paper may be blocking movement of the print head. Turn off the printer, open the cover, and remove any jammed paper or other foreign objects. Turn the printer back on again. If the lights are still flashing, contact your dealer or EPSON as described in “Where To Get Help” on page 76.</td>
</tr>
<tr>
<td>Green ⚫️ power light is off; red ⚫️️ paper and ⚫️ ink lights flashing</td>
<td>The printer may have an internal error. Turn off the printer, wait a few seconds, and turn it on again. If the lights are still flashing, contact your dealer or EPSON as described in “Where To Get Help” on page 76.</td>
</tr>
<tr>
<td>Green ⚫️ power light is off</td>
<td>The printer is not receiving power. Make sure the printer is on. Turn off the printer, plug in the power cord securely, and turn the printer on again. Make sure the outlet is working and is not controlled by a switch or timer. If in doubt, try another outlet.</td>
</tr>
</tbody>
</table>
Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer or some other source.

1. Turn off your printer and computer.
2. Disconnect the printer’s interface cable.
3. Load letter-size paper in the printer.
4. Hold down the paper button, then press and release the power button. Continue holding down the paper button until the power light starts to flash, then release it.

A test page prints showing the printer’s ROM version number, an ink counter code, and a nozzle check pattern. (If the pattern has gaps, you need to clean the print head as described on page 41.)

- If the test page prints, the problem probably lies in your software settings, interface cable, or computer, or your software may not be installed correctly.
- If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Setup and Software Installation Problems” on page 65. If nothing works, contact your dealer or EPSON as described in “Where To Get Help” on page 76.

5. Turn off the printer, reconnect the interface cable, then turn on your printer and computer.
Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink cartridge installation.

■ When you install ink cartridges, the printer must charge its print head for a minute or so. Wait until it’s finished (the green power light stops flashing) before you turn off the printer, or it may use excess ink the next time you turn it on.

■ Make sure the ink cartridges are inserted completely and the ink cartridge cover is closed completely. Also make sure no packing material remains in the printer. Turn off the printer, wait a moment, then turn it back on.

You’re having problems installing the printer software.

■ Make sure your printer is turned on and its cable is securely connected at both ends. Follow the installation steps on the Start Here sheet and make sure your system meets the requirements; see “Windows System Requirements” or “Macintosh System Requirements” on page 77.

■ Close other programs, including screen savers and virus protectors, and install again.

■ In Windows, make sure your printer is selected as the default printer and that the correct port is shown in the printer properties.

■ In Mac OS 8.6 to 9.x, if the C84 Series icon doesn’t appear in the Macintosh Chooser, you may have an extension conflict. Turn off any unnecessary extensions and restart. You may also have too many items in the Chooser. Delete any unused items and check the Chooser again.

■ If you see an error message in Windows 2000, you may not have software installation privileges. Contact your System Administrator.

■ If you’re using Windows and the USB port, make sure your system was not upgraded from Windows 95; the USB driver may not install correctly.

■ Make sure the USB Controller is working properly in Device Manager. See your Windows help system for details.
If you’re printing over a network, see your on-screen User’s Guide for instructions on configuring your printer for use on a network.

In Mac OS X, if you are using the Favorites column in Print Center, make sure your printer is selected as a Favorite. See your Mac Help for details.

Printer Problems

Only the green power light is on, but nothing prints.

- Make sure the interface cable is securely connected at both ends and meets the system requirements; see “Windows System Requirements” or “Macintosh System Requirements” on page 77.
- Run a printer check as described in “Running a Printer Check” on page 64. If the test page prints, make sure your software is installed correctly.
- If you’re printing on a network, make sure you set up your printer for network printing, as described in your on-screen User’s Guide.

The printer sounds as though it is printing, but nothing prints.

- The print head nozzles may need cleaning; see “Cleaning the Print Head” on page 41 for instructions.
- The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface.

Your printer makes noise when you turn it on or after it has been sitting for awhile.

Your printer is performing routine maintenance.
**Printing is too slow.**

Make sure your system meets the system requirements listed in “Windows System Requirements” or “Macintosh System Requirements” on page 77. If you’re printing a high-resolution image, you need more than the minimum requirements. You may also need to:

- Clear space on your hard drive or run a defragmentation utility.
- Close open programs that you’re not using.
- Increase your system’s memory (RAM).

For the fastest printing, try these tips:

- Set the Quality/Speed slider to Speed or select Draft as the Quality Option (Windows).
- In the Advanced window, turn High Speed on (Windows) or MicroWeave® off and High Speed on (Macintosh).
- If your printer is connected to a USB hub, disconnect any unused USB devices. If it still seems slow, try connecting directly to your computer’s USB port.
- If you’re using the parallel port, enable ECP/DMA mode on your computer’s parallel port. See your computer documentation or the manufacturer for instructions.
Quality Problems

You see banding (light lines).

- Clean the print head nozzles; see “Cleaning the Print Head” on page 41 for instructions.
- Select a higher Quality Option or Print Quality and turn off High Speed mode; see “Printing With Windows” on page 15 or “Printing With a Macintosh” on page 27.
- Make sure the paper Type (Windows) or Media Type (Macintosh) setting matches your paper; see page 35 for guidelines.
- Make sure the printable side of the paper is face up. It’s usually whiter or shinier.
- The ink cartridges may need replacing; see “Replacing an Ink Cartridge” on page 45.
- Try using Automatic mode (Macintosh only); See “Printing With a Macintosh” on page 27 for instructions.
- Align the print head as described in “Aligning the Print Head” on page 54.
Your print is blurry or smeared.

- Make sure your paper isn't damp, curled, or loaded face down.
- Use a support sheet with special paper, or try loading paper one sheet at a time.
- Make sure paper meets the specifications listed in your on-screen User's Guide.
- Use EPSON papers for proper saturation and ink absorption.
- Align the print head as described in “Aligning the Print Head” on page 54.
- Remove each sheet from the output tray after printing.
- Let your print dry completely before you handle it. Prints made on glossy photo paper take longer to dry. Follow the instructions included in your media pack.
- If you are using double-sided paper and printing heavily saturated or dark images on the front side of the paper, you may notice that smudges or marks appear on the front when you print the second side. If one side of the paper will contain a lighter image or text, print that side first to eliminate marks or smudging.
- Load a new sheet of plain paper and press the paper button to eject it. Do this several times. If you still have a problem, ink may have leaked inside the printer. Open the printer cover and wipe the rollers shown below with a soft, clean cloth.
Your printout is faint or has gaps.

- Clean the print head nozzles; see “Cleaning the Print Head” on page 41 for instructions.
- The ink cartridges may be old or low on ink; see “Checking the Ink Supply” on page 45.
- Make sure the paper Type (Windows) or Media Type (Macintosh) setting matches your paper; see page 21 or page 35 for guidelines.
- Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, load new paper, face up. For best results, use genuine EPSON paper.

Your printout is grainy.

- Use a higher quality paper or select a higher Quality Option or Print Quality setting; see “Printing With Windows” on page 15 or “Printing With a Macintosh” on page 27.
- Align the print head as described on page 54.
- Increase the image resolution or print it in a smaller size; see your software documentation.

You see wrong or missing colors.

- Make sure Black ink only is off (Windows) or Color ink is selected (Macintosh), even for black and white photographs.
- Clean the print head nozzles; see page 41 for instructions.
- The ink cartridges may be old or low on ink; see “Checking the Ink Supply” on page 45.
Try turning off PhotoEnhance.” Also check if you’re using a special effect that alters image colors, like Sepia.

Try using Automatic mode (Macintosh only). See “Printing With a Macintosh” on page 27 for instructions.

Try changing the Gamma setting. See “Customizing Windows Print Settings” on page 19 or “Customizing Macintosh Print Settings” on page 33 to access the Advanced settings.

Your printed colors can never exactly match your on-screen colors. However, you can use a color management system—such as ICM (Windows) or ColorSync (Macintosh)—to get as close as possible. See “Customizing Windows Print Settings” on page 19 or “Customizing Macintosh Print Settings” on page 33 for details.

For best results, use genuine EPSON ink cartridges.

The colors produced by DuraBrite inks may look slightly different than those produced by dye-based ink.

Due to the nature of pigment inks, lighting conditions can affect the appearance of your printout. For example, a print viewed in daylight may appear to have a slightly different color balance when viewed under tungsten lighting. Your printer software was designed to represent color accurately when prints are illuminated with a D 50 (daylight) light source.

Some parts of your print are not as glossy as others.

Because of the nature of pigment inks, the degree of gloss may be uneven on glossy photo papers. Gloss decreases with greater pigment saturation.

**Paper Problems**

**Paper doesn’t eject fully or is wrinkled.**

- If the paper doesn’t eject fully, you may have set the wrong paper size. Press the form paper button to eject the paper, then select the correct paper size.
- If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new paper.
Paper sheets don't feed correctly or jam in the printer.

- If paper doesn't feed or multiple pages feed, remove it from the sheet feeder. Fan the edges of the sheets, reload them against the right side of the feeder, and slide the left edge guide snugly, but not too tightly, against the paper. Don't load paper above the arrow on the left edge guide and make sure it is under the tabs on the left and right edge guides.

- If paper jams, press the paper button. If necessary, open the cover and remove any jammed or torn pieces. Load new paper and press the paper button.

- Heavily saturated prints may curl, causing a paper jam when printing on both sides of the paper.

If your paper jams frequently:

- Use new, smooth, high-quality paper, loaded printable side up.

- Don't load paper above the arrow mark on the left edge guide.

- If you're printing on both sides of the paper, try loading fewer sheets.

- Place the paper against the right edge and slide the left edge guide against it, but not too tightly.

Miscellaneous Problems

The image is inverted, as if viewed in a mirror.

Turn off Mirror Image or Flip Horizontal in the printer software or the mirror setting in your program. See “Customizing Windows Print Settings” on page 19 or “Customizing Macintosh Print Settings” on page 33 to access Advanced settings.

The printer prints blank pages.

- Make sure your printer is selected in the Print window (Windows) or in the Page Setup and Print windows (Mac OS X), or is the active printer in the Chooser (Mac OS 8.6 to 9.x).

- Clean the print head nozzles; see “Cleaning the Print Head” on page 41 for instructions.
You see incorrect characters.

- Make sure the interface cable is securely connected at both ends and meets the system requirements in “Windows System Requirements” or “Macintosh System Requirements” on page 77.

- Make sure your printer is selected in the Print window (Windows), is selected on the Page Setup and Print windows (Macintosh OS X), or is the active printer in the Chooser (Macintosh OS 8.6 to 9.x).

- If you’re using a switch box or USB hub with your printer, connect the printer directly to your computer instead.

The margins are incorrect.

- Make sure the paper settings are correct for your paper size. See “Printing With Windows” on page 15 or “Printing With a Macintosh” on page 27.

- Choose the correct margins for your paper size. The margins must be within the printable area of the page; see your electronic User’s Guide.

- If you’re using Macintosh OS X, make sure you choose the same printer in the Page Setup window and the Print window.

- Place the paper against the right edge and slide the left edge guide against it, but not too tightly.

Output is not what you expect when printing borderless photos.

- Make sure to use the correct Paper (Media) types and sizes listed on page 21 or page 36.

- Use the expansion setting to adjust how the image fits on the page. See page 25, page 39, or page 40.

- Don’t choose a custom size setting when printing borderless photos.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for multiple copies.

Image size/position is incorrect.

Make sure the paper and layout options are set correctly.
There are scratch marks on your print.

If you're printing on glossy photo paper, prints may be scratched if not handled properly. Don’t place objects on top of your prints, and be careful not to scratch them with your fingernails. For best results, frame your prints under glass.

Uninstalling Printer Software

You may need to uninstall then reinstall your printer driver and utilities if, for example, you upgrade your operating system. You don’t need to uninstall your other photo software or the EPSON Printer Information Center.

Windows

1. Click Start, and select Programs or All Programs.
2. Point to Epson or EPSON Printers, then select EPSON Printer Software Uninstall.
3. In the next window, select EPSON Stylus C84 Series and click OK. Then follow the on-screen instructions.
4. Restart your computer, then see the Start Here sheet to reinstall software.

Macintosh OS X

1. Open the Applications folder, then the Utilities folder.
2. Select Print Center, hold down the ⌘ key and select all items labeled Stylus C84, then click the Delete button.
3. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

Macintosh OS 8.6 to 9.x

1. Insert the printer software CD-ROM in your drive.
2. Double-click EPSON on the desktop, then double-click EPSON in the folder.
3. In the Main Menu, click Install Printer Driver, then click Continue.

4. On the Installer screen, click the arrow in the Easy install list at the top and select Uninstall. Then click the Uninstall button at the bottom and follow the on-screen instructions.

5. Restart your Macintosh, then see the Start Here sheet to reinstall your software.
Where To Get Help

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your EPSON SoundAdviceSM Express Code is 70445. Use this code to quickly select the EPSON Stylus C84 in SoundAdvice.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial:

- U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Please have the following information ready:

- Product name (EPSON Stylus C84)
- Product serial number (located on the back of the printer)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration and operating system version
- Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
Requirements and Notices

Windows System Requirements

To use your printer and its software, your system should have:

- A Microsoft Windows compatible PC with a Pentium®-equivalent processor (233 M H z or faster recommended)
- Windows XP, Windows Me, Windows 2000, Windows 98, or Windows NT 4.x
- 64M B RAM (128M B recommended)
- 100M B available hard disk space (200M B or more recommended)
- VGA or better display adapter and monitor (SVGA for Windows XP)
- CD-ROM or DVD drive for installing the printer software
- Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, up to 10 feet long (3 meters); the cable must have a D-SUB, 25-pin, male connector for your computer, and a 36-pin, Centronics® compatible connector for the printer.
- USB connection: a computer with preinstalled Windows XP, Me, 2000, or 98, and a Windows-compliant USB port and shielded USB “AB” cable. Using an improperly shielded USB cable may cause the printer to malfunction.

Macintosh System Requirements

To use your printer and its software, your system should have:

- An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port
- Mac® OS 8.6 through 9.x; OS X 10.1 or later (Mac OS 9.1 or later recommended)
- For Mac OS 8.6 through 9.x: 32M B RAM (64M B recommended)
  For Mac OS X: 128M B RAM (256M B recommended)
- 100M B free hard disk space (200M B recommended)
- VGA display or better
- CD-ROM or DVD drive for installing the printer software
- A shielded USB “AB” cable. Using an improperly shielded USB cable may cause the printer to malfunction.
Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.
■ Use only the type of power source indicated on the printer's label.
■ Use only the power cord that comes with this product and use the cord with this product only. Use of another cord may result in fire or electric shock.
■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
■ Place the printer near a wall outlet where the plug can be easily unplugged.
■ Do not let the power cord become damaged or frayed.
■ Avoid electrical outlets controlled by wall switches or automatic timers.
■ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the outlet's ampere rating.
■ Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches between the back of the printer and the wall.
■ Leave enough room in front of the printer for the paper to be fully ejected.
■ Do not place the printer near a radiator or heating vent or in direct sunlight.
■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
■ When storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. This may allow ink to leak from the ink cartridges.
■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.

Caution: Always turn the printer off using the power button. Don’t switch off the power strip or unplug the printer until the green power light is off.
■ Do not block or cover the openings in the printer’s case or insert objects through the slots.
■ Except as specifically explained in this manual, do not attempt to service the printer yourself.
Unplug the printer and refer servicing to qualified service personnel under the following conditions:
If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not put your hand inside the printer or touch the cartridge during printing.
- Do not move the print head by hand. You may damage the printer.
- Install the ink cartridge immediately after you remove it from its plastic package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
- Do not shake the ink cartridge after opening the plastic package; this can cause leakage.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of first installing them.
- Store ink cartridges in a cool, dark place.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
- Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
- Each time a cartridge is removed and installed, some ink is used when the printer performs a reliability check.
- Store an ink cartridge with the label facing upward. Don't store the cartridge upside down.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are removed. Tape the ink cartridge holder to the printer case to make sure it remains in the proper position.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Ink Jet Printer
Model: B251A

ENERGY STAR COMPLIANCE

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the EPSON printer covered by this limited warranty statement, if purchased new and used in the United States or Canada, conforms to the manufacturer's specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer's specified usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the warranty period, please call the EPSON Connection at (562) 276-7525 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson's option, may be another model of like kind and quality. Epson's liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ■ P. O. Box 93012 ■ Long Beach, CA 90809-3012
Index

A
Accessories, 13, 44, 76
Advanced print settings
  Macintosh, 33 to 34
  Windows, 19 to 20
Aligning print head, 54 to 57
Animated tutorials, 9 to 10

B
Banding, 54 to 57
Blank pages, 72
Blurry print, 69
Borderless papers, 22 to 23, 37
Borderless printing
  Macintosh, 36 to 40
  Windows, 22 to 25

C
Cable, printer, 77
Cartridges, ink, see Ink cartridges
Characters, incorrect, 73
Checking
  ink supply, 45 to 46
  print head alignment, 54 to 57
Cleaning
  print head, 41 to 43
  printer, 57
Color management, 19, 29
Colors
  matching, 70 to 71
  missing, 70 to 71
  wrong, 70 to 71
Control panel, 63
Copies, 73

D
Customizing print settings
  Macintosh, 33 to 34
  Windows, 19 to 20

D
Declaration of Conformity, 81
Default printer settings, 18
Documentation, 8 to 10
DuraBrite inks, 7

E
Energy Star, 81
Envelopes, 12
EPSON Help, 76
  paper, 13 to 14
  PhotoCenter, 8
  Printer Information Center, 8, 9 to 10
  Store, 13, 76
Exif Print, 7

F
Faint print, 70
FCC Compliance Statement, 80
Flipped image, 72

G
Gamma setting, 71
Gaps in print, 41 to 43, 54 to 57, 68, 70
Gloss, 71
Grainy print, 70
**H**

Head cleaning utility, 41 to 43
Help, EPSON, 76

**I**

Ink cartridges
  purchasing, 44
  replacing empty, 45 to 50
  replacing old, 44, 50 to 53
  safety instructions, 46, 79
Ink supply, checking, 45 to 46

**J**

Jams, paper, 72

**L**

Light print, 70
Lights, 63
Loading paper
  borderless papers, 23, 37
  envelopes, 12
  single sheets, 11 to 12
  special EPSON papers, 13 to 14

**M**

Macintosh
  advanced print settings, 33 to 34
  customizing print settings, 33 to 34
  printing, 27 to 40
  system requirements, 77
  uninstalling printer software, 74 to 75
Margins, incorrect, 73
Matching colors, 70 to 71
Media type setting, 21, 35 to 36
Mirror image, 72
Monitoring print status, 18, 30, 32
Movies, 9 to 10
Moving printer, 58 to 60

**N**

Noise, 65, 66
Nozzle check, 43, 64

**P**

Page layout settings
  Macintosh, 29, 32
  Windows, 20
Paper
  borderless papers, 22 to 23, 37
  envelopes, 12
  feeding problems, 71 to 72
  single sheets, 11 to 12
  special EPSON papers, 13 to 14
  storing prints, 22, 36
  type setting, 21, 35 to 36
Part numbers
  EPSON paper, 13
  ink cartridges, 44
Photo RPM, 19, 33, 34
PhotoEnhance, 71
Photo-sharing website, 8
Print head
  aligning, 54 to 57
  cleaning, 41 to 43
  nozzle check, 43
Print head alignment utility, 54 to 57
Print quality, 68 to 71
Print settings, customizing, 19 to 20, 33 to 34
Print Show, 9 to 10
Printer
cable, 77
check, 64
cleaning, 57
control panel, 63
noise, 65, 66
problems, 66 to 67
safety instructions, 78 to 79
transporting, 58 to 60
Printing
borderless, 22 to 25, 36 to 40
Macintosh, 27 to 40
Windows, 15 to 25
Problems
blank pages, 66, 72
blurry print, 69
characters, 73
colors, 70 to 71
faint print, 70
gaps in print, 68, 70
gloss, 71
grainy print, 70
inverted image, 72
margins, 73
multiple copies, 73
paper feeding, 71 to 72
print quality, 68 to 71
printer, 66 to 67
scratches, 74
slow printing, 67
smearing, 69
software, 65 to 66, 74 to 75
wrong colors, 70 to 71

R
Replacing ink cartridges
empty, 45 to 50
old, 44, 50 to 53
RPM technology, 7

S
Safety instructions, 46, 78 to 79
Scratches on print, 74
Sheet feeder
cleaning, 57
problems, solving, 72
Slow printing problem, 67
Smeared print, 69
Smudges, 69
Software
description, 8
installation problems, 65 to 66
uninstalling, 74 to 75
Special EPSON papers, 13 to 14
Storing prints, 22, 36
System requirements, 77

T
Technical support, 76
Test page, 64
Transporting printer, 58 to 60
Troubleshooting, see Problems

U
Uninstalling printer software, 74 to 75
USB, 77
User's Guide, 9 to 10
Utilities
aligning print head, 54 to 57
checking ink supply, 45 to 46
cleaning print head, 41 to 43
nozzle check, 43
W

Warranty, 82
Windows
  advanced print settings, 19 to 20
  default printer settings, 18
  installing printer software, 10
  printing, 15 to 25
  system requirements, 77
  uninstalling printer software, 74 to 75
Wrinkled paper, 71 to 72
EPSON Ink Jet Papers

Use EPSON paper and inks to get the best results from your EPSON printer! EPSON papers are specially designed to work with EPSON quick drying inks.

**Premium Bright White Paper**
Premium Bright White Paper has a sleek, ultra-smooth surface, and 108+ brightness. This paper delivers crisp black text and vivid, colorful images. It’s perfect for everyday printing—especially two-sided documents.

**Double-Sided Matte Paper**
Double-Sided Matte Paper is coated on both sides with a flat matte finish for photographic quality output. It’s the ideal media when you need high-quality double-sided printing for brochures, newsletters, or flyers.

**DuraBrite Ink Glossy Photo Paper 4 × 6**
DuraBrite® Ink Glossy Photo Paper is a high-gloss, heavyweight paper that is optimized for use with EPSON DuraBrite inks. This paper is perfect for reprints, snapshots, and enlargements. Also available in letter size.

Featuring EPSON’s exclusive new DuraBrite ink technology for superior clarity, lightfastness, and water resistance.

For more information on other EPSON products and fun project ideas, look for the EPSON Print Lab™ Series at www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ordering information.
How To Order EPSON Ink and Paper

To order EPSON ink cartridges and paper, call (800) 873-7766 or visit the EPSON Store at www.epsonstore.com (U.S. sales only). In Canada, call (800) 463-7766 for dealer referral.

**EPSON Ink Cartridges**
Black  
T043120 (high capacity)*  
T044120*  
Cyan  
T044220  
Magenta  
T044320  
Yellow  
T044420

*Availability of black ink cartridge types varies by location.

**EPSON Papers**

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>EPSON DURABrite Ink Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041731</td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches</td>
<td>S041734</td>
</tr>
<tr>
<td>EPSON Photo Quality Inkjet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>EPSON Enhanced Matte Paper (Archival Matte Paper)</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041341</td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper (Photo Paper)</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041141 (20)/ S041649 (50)/ S041271 (100)/ S041272 (500)</td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches</td>
<td>S041134 (20)/ S041671 (50)</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041140</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td>EPSON Inkjet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041064</td>
</tr>
<tr>
<td>EPSON Photo Quality Inkjet Cards</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041054</td>
</tr>
</tbody>
</table>

**Notes:** The names of EPSON papers do not always match the paper type settings in your printer software. See the table on page 21 or page 35, or the instructions that came with your paper to select the correct paper type setting.

Availability of paper types varies by location. EPSON is always adding new papers to this list. Visit the EPSON Store at www.epsonstore.com and check out the latest media.